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License agreement
EMERGING INFORMATION SYSTEMS INC. (“EISI”) 
SOFTWARE LICENSE AGREEMENT

(the “License Agreement”)

WHEREAS:
A.   EISI is the owner of and is entitled to license certain computer programs which are marketed in the aggregate 
under the NaviPlan® trademark (the “NaviPlan Software”). In addition, EISI has entered into one or more agreements 
with third parties (each a “Third Party Provider”) pursuant to which EISI is entitled to integrate software owned by the 
Third Party Providers (the “Third Party Software”) into the NaviPlan Software and to license same for use by clients of 
EISI on the terms and conditions of this License Agreement.

B.   EISI, or the duly authorized licensee or sublicensee of EISI with whom you are dealing, (the “Licensor”) is willing 
to grant you (sometimes called the “User”) a personal, non-exclusive, non-transferable license which would enable you 
to use, in accordance with and subject to the provisions of this License Agreement, either for evaluation during a trial 
period to be determined by EISI or for such longer term during which you pay the Licensor its required license fees, 
such of the NaviPlan Software, and any enhancements and updates to the NaviPlan Software that are made available 
to the User by the Licensor from time to time, and Third Party Software, together with the related documentation, as 
you agree to license (the “Licensed Software”).

C.  The licensor encourages you to read and fully understand this license agreement before deciding 
whether you are willing to be bound by it. If you have any questions, we recommend that you show this 
license agreement to your lawyer and obtain advice as to your rights and obligations before becoming 
bound by it.  If, after you fully understand the License Agreement, you decide that you are willing to become bound 
by all of its terms and conditions, please click on the location indicating “I accept the terms in the License Agreement” 
and you will then be bound by this License Agreement and, subject to payment of license fees when due (for licenses 
other than during a trial, for which no fees are payable), you will be entitled to use the Licensed Software. If you click 
the location indicating “I do not accept the terms in the License Agreement” or click on the “Cancel” button prior to 
accepting the terms of the License Agreement, you will not be entitled to use or be granted access to the Licensed 
Software and you may not copy or install the software.

THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT ARE AS FOLLOWS:
1.   The Licensor hereby grants the User a personal, non-exclusive, non-transferable license to use, in accordance with 
and subject to the provisions of this License Agreement, the Licensed Software.

2.   If the User is entitled to use the Online Version of the Licensed Software, in order to gain access to it, the User 
must log in to the Licensor’s designated Web Site using a user name and password issued by the Licensor that will be 
unique to the User (the “User ID”). It is a condition of this License Agreement that the User will keep the User ID 
confidential, will not share the User ID with anyone else and will not permit anyone other than the User to have access 
to the Licensed Software by using the User ID.

3.   If the User is entitled to install a copy of the Licensed Software in the User’s computer, regardless of whether that 
copy is downloaded from a Web Site or is provided to the User on CD ROM, the User may not rent, lend, lease, donate, 
pledge, sell, transfer, sublicense, assign or otherwise convey the Licensed Software or any copy thereof to another 
party. In addition, the User covenants and agrees with EISI that the User shall not (and shall not permit any employee 
or other third party to) copy, use, analyze, reverse engineer, decompile, disassemble, translate, convert or apply any 
procedure or process to the Licensed Software in order to ascertain, derive, and (or) appropriate for any purpose 
whatsoever, the source code or source listings for the Licensed Software or any trade secret information or process 
contained in the Licensed Software. The User is not entitled to and agrees that the User will not change or cause the 
Licensed Software or its data structures to be changed or make any attempt to do so. The User shall be entitled to 
make a single copy of the Licensed Software for backup purposes. No other copies of the Licensed Software shall be 
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made. Both copies of the Licensed Software must be kept in the User’s possession. If the Licensor provides the User 
with an updated copy of the Licensed Software, the User may use either the current or prior version of the Licensed 
Software, but never both versions at the same time.

4.  The license granted hereby is for the User, in his or her capacity as a professional financial planner, to use the 
Licensed Software to prepare financial plans for the User’s existing and prospective customers, who must be 
individuals who are endeavouring to develop a plan for their and their family’s future. This license does not entitle the 
User to use the Licensed Software for the purpose of assisting any other persons, including other financial planners, in 
the preparation of plans, unless those other persons are also licensed to use the Licensed Software.

5.  The User shall be responsible, at his or her own cost, for acquiring all computer hardware and software to enable 
him or her to use the Licensed Software.

6.   Subject to the rights of the Third Party Providers of any Third Party Software licensed to EISI, the Licensed 
Software is owned by EISI and is protected by copyright and (or) trade secret law. Under this License Agreement, the 
User acquires the right to use the Licensed Software for the limited purposes set forth in this License Agreement but 
does not acquire any rights of ownership in the Licensed Software. As between the User and EISI, EISI shall at all 
times retain all right, title and interest in the Licensed Software on its own behalf and on behalf of the Third Party 
Providers of the Third Party Software.

7.   This License Agreement comes into effect immediately upon the User’s agreeing to be bound by it and, subject to 
the User’s having paid the license fees for the Licensed Software (for licenses other than during a trial, for which no 
fees are payable), will continue in effect for the term during which you have agreed to pay and pay the Licensor its 
required license fees (the “Term”). The last day of the Term is called the Expiry Date. Shortly before the Expiry Date, 
the Licensor will send the User an invoice for renewal fees (which may be increased but not more than once each year) 
for use of the Licensed Software (subject to any changes that may be required with respect to EISI’s continuing right 
to sublicense the Third Party Software) during the proposed renewal period. The User will have 30 days within which 
to pay the invoiced amount. Upon payment being made, the Term will be extended for the renewal period. If the User 
does not make payment, the User’s license to use the Licensed Software will expire on the Expiry Date and all of the 
User’s rights to use the Licensed Software shall come to an end. Upon termination of this License Agreement as a 
result of breach of any of its terms and conditions by the User or expiry of the Term, the User shall make no further 
use of the Licensed Software, shall purge same from any computer into which it has been installed and shall destroy 
any copies thereof in his or her possession. In that event, the Licensor shall be entitled, but not obliged, to delete all 
information related to the User that has been provided to it, including data and financial plans pertaining to the User’s 
customers, to bar the User from having access to the Licensor’s Web Site and to any Licensed Software in the control 
of the Licensor. 

8.   Neither EISI, nor any Licensor other than EISI nor any Third Party Provider represents or warrants that the 
Licensed Software will meet the User’s requirements, that operation of the Licensed Software will be uninterrupted or 
error-free, or that all errors in the Licensed Software will be corrected.

9.  EISI is not in the business of providing advice with respect to the preparation of financial plans. The liability of EISI 
under this license agreement is limited to the correction of any error or malfunction in the licensed software and shall 
not include liability for loss of data, loss of computer time, any direct or indirect damages or any consequential, 
incidental, exemplary, punitive or special damages sustained by the User of the licensed software or by any third party 
who advances a claim against either EISI or the User, however caused and based on any theory of liability arising out 
of or relating to this license or the use of the licensed software, and regardless of whether EISI was advised of the 
possibility of such damages prior to or after this license came into effect. EISI disclaims all other warranties and 
conditions, either express or implied, including but not limited to implied warranties and conditions of merchantability 
and (or) fitness for a particular purpose, whether statutory or otherwise, which are specifically excluded. The User of 
the licensed software acknowledges that the limitations set forth in this section are integral to the granting of this 
license and that, but for these limitations, fees payable by the User would have been subject to further negotiation and 
there is substantial likelihood that this license would not have been granted.
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10.  The User agrees that no third party provider (which includes the third party provider and its stockholders, 
directors, officers, employees, and agents), of third party software warrants the accuracy, completeness, timeliness, 
reliability, fitness for a particular purpose or merchantability of any information to which User has access through the 
licensed software. User also agrees that no third party provider warrants the materials, workmanship or performance 
of the third party software. All other warranties, express or implied (including implied warranties of merchantability, 
fitness for a particular purpose and against intellectual property infringement by a third party provider) are excluded. 
In no event shall any third party provider be liable for (I) any loss, cost or damage, whether caused in whole or in part 
by negligence or otherwise, suffered by the User as a result of any decision made or any action taken in reliance upon 
information to which the User had access through the licensed software, or (II) any trading losses, lost profits or any 
other consequential, special or incidental damages, whether or not reasonably foreseeable, and even if advised of the 
possibility of such damages. The User acknowledges that the third party software and any and all information 
accessible through such software is the sole and exclusive property of the third party provider, which retains any and 
all intellectual property rights therein. The User agrees not to redistribute such information to any third party without 
written consent of the proper owner thereof. The User acknowledges that the third party providers are third party 
beneficiaries of, and are relying upon, the foregoing provisions.

  11. Each of the third party providers makes no warranties, guarantees, or representations of any kind, express or 
implied, with respect to the operation, capacity, speed, functionality, qualifications, or capabilities of the third party 
software provided by that third party provider that is integrated into the licensed software or any services, goods, 
personnel or resources provided hereunder, including without limitation, any implied warranty of merchantability or 
fitness for a particular purpose.  Each of the third party providers makes no representation, warranty or covenant 
concerning the accuracy, completeness, sequence, timeliness or availability of the third party software provided by 
such third party provider or the information accessed thereby or the likelihood of profitable trading using the said third 
party software or such information. As between each third party provider and the User, the User accepts full 
responsibility for any investment decisions or stock transactions made by its customers using such third party software 
or such information. No sales personnel, employees, agents or representatives of any third party provider are 
authorized to make any representation, warranty or covenant on behalf of such third party provider. No third party 
provider nor any of its affiliates represents or warrants that its third party software will be uninterrupted or error-free. 
The User expressly agrees that use of each third party software and the information is at its sole risk and that no third 
party provider shall be responsible for any termination, interruption of services, delays or errors caused by any 
transmission or delivery of the third party software and/or information or caused by any communications service 
providers.

12.  The User agrees that all communications between EISI, or any Licensor other than EISI, and the User, including 
information respecting enhancements and updates to the Licensed Software, may be by way of e-mail to the e-mail 
address provided by the User.

13.  If the version of the Licensed Software that is being licensed is based on tax principles of the United States:

(a)  The Licensed Software shall not be installed or used in any country that would violate the rules and regulations of 
the United States Department of Commerce, Bureau of Export Administration.

(b)  The Licensed Software is a “commercial item”, as defined at 48 C.F.R. 2.101 (October 1995) comprised of 
“commercial computer software” and “commercial computer software documentation” in accordance with 48 C.F.R. 
12.212 (September 1995). Pursuant to 48 C.F.R. 12.212 and 48 C.F.R. 227-7202-1 to and including 227-7202-4 ((June 
1995), all U.S. Government End Users acquire the Licensed Software with only the rights that are set forth herein. 
Emerging Information Systems Inc., 500-330 St. Mary Avenue, Winnipeg MB Canada R3C 3Z5.

14.  If you have been licensed to use the Licensed Software by a duly authorized licensee or sublicensee of EISI, then 
in consideration of EISI’s having consented to your being licensed as such, EISI shall be entitled to enforce this License 
Agreement as if it had directly licensed the Licensed Software to you on the terms and conditions of this License 
Agreement.
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15.  This License is governed by the laws of the Province of Manitoba and the laws of the Canada in force therein (with 
the exception of choice of law principles) and the Court of Queen’s Bench of the said Province shall have exclusive 
original jurisdiction over any dispute respecting this License Agreement. If any part of this License is found to be 
unlawful, void or unenforceable, then that provision shall be deemed severed from this License and will not affect the 
validity and enforceability of any of the remaining provisions.
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About this guide

Conventions used in the Quick Start guide   1

Ab
it handy for easy reference.

Co

italized and italicized. For example,

ick, or enter appear in bold. For example,

 separated by en dashes. For example,

t – Add Family Member.
rated by plus signs if they are to be 
out this guide
This guide will help you install NaviPlan® software. Keep 

nventions used in the Quick Start guide
The Quick Start guide uses the following conventions:
• The names of items that are labeled on the screen are cap

The License Agreement dialog box opens.
• In procedures, the names of items that you must select, cl

 Click OK, and then enter Base Plan.
• Multiple menu command instructions are listed together,

Go to the Data menu, and then select Data – Clien
• Keyboard references appear in uppercase with keys sepa

pressed together. For example,

CTRL+ALT+DELETE 
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2   F

Fi
re are other places you can look for more 

log box, or item within NaviPlan is to use 

t that appears (this will not work if you 

g box

l Time)

s

inding more information

nding more information
If you have a question that is not answered in this guide, the
information: 

www.eisi.com/
Visit our Web site for

Help
The fastest way to get information about any command, dia
Help. There are four ways to access Help:
• Select the Help menu from the program’s menu bar

• Right-click the desktop, and then click Help from the lis
have any dialog boxes open)

• Click the Help button in the top-right corner of any dialo

• Select an item, and then press F1

Technical Support
You can contact EISI Technical Support for more help.
• Visit EISI User Services

• Telephone: (888) 692-3474 (Mon.–Fri., 7am–7pm Centra

• Fax: (204) 975-3726

• online tutorials • NaviPlan product new
• training information • technical support
• NaviPlan tips • support forums

https://users.eisi.com/
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System requirements   3

In
nd how to authorize it. Before you begin, 

Sy

 768 with 256 color palette

 and the use of some features.
r compatible processor recommended.
rated in .rtf.
ser, but is used by NaviPlan.

inimum processor & RAM*

III 1.0GHZ* (P-IV 2.2GHZ+)**
GB+) of RAM

III 1.0GHZ* (P-IV 2.2GHZ+)
B+)

sion: Internet Explorer 6.0 SP2+****
stalling and upgrading NaviPlan
This section describes how to install or upgrade NaviPlan a
review the system requirements.

stem requirements
Your computer system must have the following:
• Windows XP, or Windows Vista™

• Free hard disk space: 350MB

• CD-ROM drive 

• Super VGA display with a minimum resolution of 1024 x

• Mouse or compatible pointing device

*Minimum requirements will limit application performance
**Intel Pentium/Celeron family, AMD K6/Athlon/Duron, o
***Microsoft Word is only a requirement if reports are gene
****Internet Explorer does not need to be the primary brow

Operating system M

Windows XP • Pentium® 
• 512MB* (1

Windows Vista • Pentium® 
• 1GB* (2G

Minimum version of Microsoft Word: 2000+***
Minimum version of Adobe Reader: 6.0+

Browser ver
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In
 stand-alone computer.

are. It also contains NaviPlan user 
r Adobe Acrobat Reader, which allows 

our CD-ROM drive. The AutoPlay 
 CD" on page 11).

d to display the program’s option menu, 
stall NaviPlan Extended. 

Clic
proc

Win
in th
and
nstalling on a stand-alone computer

stalling on a stand-alone computer
This section explains how to install NaviPlan software on a

Installing from the NaviPlan CD
The NaviPlan CD contains a full release version of the softw
guides, product order forms, and the installation program fo
you to view and print the documentation.
To install NaviPlan from the CD, follow these steps:
1. Start Windows, and then insert the NaviPlan CD into y

window opens (if it does not, see "Troubleshooting the

Figure 1: AutoPlay window

2. Select either NaviPlan Standard or NaviPlan Extende
and then click either Install NaviPlan Standard or In

k Cancel at any time to stop the installation 
ess.

dows Vista users: Right-click the setup.exe file 
e Setup folder. Select Run as administrator, 
 then click Continue.
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Installing on a stand-alone computer   5

 continue the installation process. The 

ou accept the terms of the agreement, 
 then click Next.
 
Figure 2: NaviPlan Setup – Welcome dialog box

3. Read the displayed information, and then click Next to
License Agreement dialog box opens.

4. Read the License Agreement information carefully. If y
click I accept the terms in the license agreement, and

The Choose Destination Location dialog box opens.
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6   I

aviPlan Standard or Naviplan Extended 

er, click Browse. The Choose Folder 
nstalling on a stand-alone computer

 
Figure 3: Choose Destination Location dialog box

5. Click Next to install the NaviPlan program files in the N
program folder.

To install the NaviPlan program files in a different fold
dialog box opens. 
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Installing on a stand-alone computer   7

en click OK. The Choose Folder dialog 
tion dialog box. Click Next to continue 

.

 

.

Figure 4:  Choose Folder dialog box

Select or enter the path to the destination folder, and th
box closes and you are returned to the Choose Destina
the installation process.
The Select Data Directory dialog box opens.
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an program directory, click Next.

wse. The Choose Folder dialog box 

en click OK. The Choose Folder dialog 
tion dialog box. 

ator that displays the status of each file as 
nstalling on a stand-alone computer

Figure 5: Select Data Directory dialog box

6. To store your client files in a Data folder in the NaviPl

To store your client files in a different folder, click Bro
opens. 
Select or enter the path to the destination folder, and th
box closes, and you are returned to the Choose Destina
Click Next to continue the installation process.
The Setup Status dialog box opens with a progress indic
it is copied to your drive.



Installing and upgrading NaviPlan

Installing on a stand-alone computer   9

viPlan shortcut placed on your desktop. 

izard Complete dialog box opens. This 
r.

 is now ready to use.
ions and restart your computer, select 
and NaviPlan is ready to use.
plications and restart your computer, 

 but you will be unable to use the 
7. The Question dialog box opens to ask if you want a Na
Click Yes or No.

Figure 6: Question dialog box

8. The Question dialog box closes and the Install Shield W
dialog box may ask if you want to restart your compute

If the question does not appear, click Finish. NaviPlan
If you want the program to shut down all open applicat
Yes, and then click Finish. Your computer is restarted 
If you don’t want the program to shut down all open ap
select No, and then click Finish. NaviPlan is installed,
application until you restart your computer.
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 Installing on a stand-alone computer

Figure 7: Install Shield Wizard Complete dialog box
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Installing on a stand-alone computer   11

isk into your CD-ROM drive. If this does 

ove fingerprints or paper dust. Reinsert 

CD-ROM drive does not support 
, try starting the CD manually:
our CD-ROM drive.

n select Run. The Run dialog box opens.

cing D: with the letter of your CD-ROM 
Troubleshooting the CD
The NaviPlan CD plays automatically when you insert the d
not happen, try the following:
• Remove the disk, and then reinsert it.
• Remove the disk and wipe it with a soft, dry cloth to rem

the disk.

If the AutoPlay problems continue, it may be because your 
AutoPlay, or the AutoPlay feature is disabled. In either case
1. Start Windows, and then insert the NaviPlan CD into y

2. On the Windows taskbar, click the Start button, and the

Figure 8: Run dialog box

3. In the Open field, enter D:Autorun\Autorun.exe (repla
drive), and then click OK.
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In
echnical Support for instructions.
l Time)
 Installing on a network server

stalling on a network server
If you are installing NaviPlan on a network server, contact T
• Telephone: (888) 692-3474 (Mon.–Fri., 7am–7pm Centra

• Fax: (204) 975-3726
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Authorizing NaviPlan   13

Au
e NaviPlan program. If you are installing 
omplimentary 30-day evaluation period. 
s been authorized.
 period or you can wait until after the 

the software. If you do not see the 
The Security dialog box opens.

The
a un
you
gen
thorizing NaviPlan
These instructions assume that you have already installed th
the program on your computer for the first time, there is a c
After this period expires, the software will not run until it ha
You can authorize the software during the 30-day evaluation
evaluation period expires.
1. Open NaviPlan and you will be prompted to authorize 

prompt, go to the File menu, and then select Security. 

Figure 9: Security dialog box – Authorize tab (sample Site Code shown)

 top section of the Security dialog box displays 
ique Site Code that is generated based on 

r installed version. This Site Code is used to 
erate a unique authorization key for you. 
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thorization key from the EISI Customer 

pport number is displayed, click Auto 
zed. 
 692-3474 (Mon.–Fri. 9am–5pm Central 
 the Authorize tab of the Security dialog 

ments field, indicate whether you are 

e form contains your unique Site Code 

ion Key will be sent to you.
 Authorizing NaviPlan

2. Use one of the following methods to obtain a unique au
Service department:

• If you have an Internet connection and if a product su
Authorize. Your installation is automatically authori

• Telephone the Customer Service department at (888)
Time). When asked, relay the Site Code displayed on
box.

• Click Prepare Authorization Form. 
The Prepare Authorization Form dialog box opens. 

3. Complete all fields in the dialog box. In the Other Com
authorizing your primary or secondary computer.

4. Click Print to print a form that you can fax to EISI. Th
along with EISI’s phone and fax numbers.

5. Fax the form to EISI at (204) 975-3726. An Authorizat

Figure 10: Prepare Authorization Form dialog box
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Authorizing NaviPlan   15

er appears automatically.

 box.
6. Enter the Authorization Key. The product support numb

7. Click Authorize, and then click OK to close the dialog
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M
mple, if you

sfer the Authorization Key before moving 
ware becomes unusable.
n authorized on two computers. To use 
nse, you need to transfer the 

l the Customer Service department at 
entral Time).

oppy disk.

ed computer.

horization Key
ollow these steps:

urity dialog box opens.

Mov
void
to b
 Moving your Authorization Key

oving your Authorization Key
In some situations you may need to move NaviPlan. For exa
• reformat your hard disk

• get a new hard disk or computer

• install the program on another computer

If you need to move NaviPlan for any reason, you must tran
the software. Otherwise the key is invalidated and your soft
A NaviPlan license agreement permits you to have NaviPla
NaviPlan on a third computer without acquiring another lice
Authorization Key from one of the authorized computers.
If you have any questions about your Authorization Key, cal
(888) 692-3474 and select option 3 (Mon.–Fri., 7am–7pm C
To transfer an authorization key, follow these steps:
1. Prepare a floppy disk.

2. Transfer the key from the authorized computer to the fl

3. Transfer the key from the floppy disk to the unauthoriz

Preparing a floppy disk to transfer an Aut
To prepare a floppy disk to transfer an Authorization Key, f
1. Open the unauthorized version of NaviPlan.

2. Go to the File menu, and then select Security. The Sec

3. Go to the Transfer tab.

CAUTION

ing the Authorization Key at the wrong time 
s the authorization and causes your software 
ecome unusable!
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Moving your Authorization Key   17

rk.

tify the authorized computer and the 
 are transferring the key between two 
home and work computers, then choose 
e to refer to as work for the purpose of 

ome (whichever one you did not choose 

 select that disk drive from the Use 
Figure 11: Security dialog box – Transfer tab

4. From the This computer list, select either Home or Wo

When transferring an Authorization Key you must iden
unauthorized computer as either Home or Work. If you
computers (or two hard drives), and not between your 
one computer (or hard drive) to refer to as home and on
the transfer.

5. From the Other computer list, select either Work or H
in the previous step).

6. Insert a prepared floppy disk in the disk drive, and then
Floppy Drive list.
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pears to notify you that the disk is ready 

n authorized computer to a 

sk, you must prepare the floppy disk to 
k to transfer an Authorization Key" on 

er to a floppy disk, follow these steps:

urity dialog box opens.

e (the option you selected from the 
nsfer).

ify the authorized computer and the 
 are transferring the key between two 
home and work computers, then choose 
e to refer to as work for the purpose of 

ork (whichever one you did not choose 

 select that disk drive from the Use 

red to the floppy disk, and a message 
 Moving your Authorization Key

7. Click Prepare to Receive a Transfer In. A message ap
to receive an authorization key.

8. Click OK. The message box closes.

9. Close NaviPlan and remove the disk from the drive.

Transferring an Authorization Key from a
floppy disk
Before you can transfer an Authorization Key to a floppy di
receive the key. For instructions, see "Preparing a floppy dis
page 16.
To transfer an authorization key from an authorized comput
1. Open the authorized version of NaviPlan.

2. Go to the File menu, and then select Security. The Sec

3. Go to the Transfer tab.

4. From the This computer list, select either Work or Hom
Other computer list when preparing the disk for the tra

When transferring an authorization key you must ident
unauthorized computer as either Home or Work. If you
computers (or two hard drives), and not between your 
one computer (or hard drive) to refer to as home and on
the transfer.

5. From the Other computer list, select either Home or W
in the previous step).

6. Insert a prepared floppy disk in the disk drive, and then
Floppy Drive list.

7. Click Transfer Out. The Authorization Key is transfer
appears confirming the successful transfer.
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ens to ask if you want to prepare the 
.

fer the Authorization Key back to this 
another message appears to notify you 

ansfer the Authorization Key back to this 
 the next step.

 floppy disk to an 

nauthorized computer, follow these steps:

urity dialog box opens.

rk (the option you did not choose when 

tify the authorized computer and the 
 are transferring the key between two 
home and work computers, then choose 
e to refer to as work for the purpose of 

ome (whichever one you did not choose 

 in the disk drive, and then select that 
8. Click OK. The message box closes and another one op
floppy disk to transfer the Authorization Key back later

9. If you are going to want to use this floppy disk to trans
computer later, click Yes. The message box closes and 
that the disk has been prepared.

If you are not going to want to use this floppy disk to tr
computer later, click No. The message box closes. Skip

10. Click OK. The message box closes.

11. Close NaviPlan and remove the disk from the drive.

Transferring an Authorization Key from a
unauthorized computer
To transfer an Authorization Key from a floppy disk to an u
1. Open the unauthorized version of NaviPlan.

2. Go to the File menu, and then select Security. The Sec

3. Go to the Transfer tab.

4. From the This computer list, select either Home or Wo
transferring the key to the floppy disk).

When transferring an Authorization Key you must iden
unauthorized computer as either Home or Work. If you
computers (or two hard drives), and not between your 
one computer (or hard drive) to refer to as home and on
the transfer.

5. From the Other computer list, select either Work or H
in the previous step).

6. Insert the floppy disk containing the Authorization Key
disk drive from the Use Floppy Drive list.
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the Authorization Key was transferred 

 of NaviPlan is now operational.
 Moving your Authorization Key

7. Click Transfer In. A message appears to confirm that 
successfully.

8. Click OK. The message box closes.

9. Click OK. The Security dialog box closes. This version
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Up

es. This new feature enables quicker 
 the past. The Update feature uses 

u, and then select Update. Follow the on-
ugh the process.
ment exists. You cannot download or 

 version 8.0 to version 9.0, you must first 
s:
ninstall or NaviPlan Extended - 

Shield Wizard prepares to uninstall.

elected application and all of its 
izard uninstalls the application.

on in the same location as your previous 
pdates the necessary files. 
cedure described earlier in this guide. For 
and-alone computer, follow the 
.
 version of NaviPlan. If you have any 
 (888) 692-3474 (Mon.– Fri., 7am– 7pm 

It is 
loca
avo
crea
will 
on w
fold
ope
ope
grading NaviPlan

Updates and patches
NaviPlan now enables users to download updates and patch
access to patches and software updates than was available in
Microsoft .NET Framework to locate applicable patches. 
To access the NaviPlan Update feature, go to the Help men
screen instructions and NaviPlan Update will guide you thro
NaviPlan Update is only available if a current support agree
install patch files after your support agreement expires.

Major version upgrades
Before installing a major version upgrade, for example from
uninstall the existing version. To uninstall, follow these step
1. In Windows Explorer, click the NaviPlan Standard - U

Uninstall icon in your NaviPlan directory. The Install 

2. The question “Do you want to completely remove the s
components?” displays. Click OK. The Install Shield W

3. Click Finish to close the Install Shield Wizard. 

After uninstalling the previous version, install the new versi
version of NaviPlan. The NaviPlan upgrade automatically u
To install an upgrade, follow the appropriate installation pro
example, if you are installing an upgrade from CD onto a st
instructions in "Installing from the NaviPlan CD" on page 4
Your existing authorization should allow you to run the new
questions, contact the EISI Technical Support department at
Central Time).

best that you install the upgrade in the same 
tion as your existing version of NaviPlan to 
id creating two separate installations. If you 
te two separate installations, each instance 

potentially use its own data folder (depending 
hat you selected as the application and data 

er locations). Also, once a client file has been 
ned in a newer version, it can no longer be 
ned in older versions.
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cessor to which documents can be exported   23

M
 the application. For example, you can

t files

Ch ported
ord processing application shown in the 

n change the application shown here.
xported, follow these steps:

 Preferences dialog box opens, and the 
Changing the word pro

odifying NaviPlan after installation
After installing NaviPlan you can modify some attributes of
• change the location where your client files are stored

• control whether or not NaviPlan creates backups of clien

• control how often NaviPlan saves client information

anging the word processor to which documents can be ex
Anytime you export a NaviPlan document, it is sent to the w
Edit field of the Preferences dialog box. At any time you ca
To change the word processor to which documents can be e
1. Open NaviPlan.

2. Go to the Edit menu, and then select Preferences. The
General tab is displayed.
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g application.

ram dialog box where you can browse to 
 Changing the word processor to which documents can be exported

Figure 12: Preferences dialog box – General tab

3. In the Editor field, enter the path to the word processin

OR
Click the browse button to open the Select Editor Prog
the application. Click OK to close the dialog box.

4. Click OK to close the Preferences dialog box.
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Ad
ns in NaviPlan. This includes such 
rts view), and the title page of the Client 
n you want to establish a consistent look 

raphic file not exceed a maximum width 
on the left side of the page and the text 
 also recommended that the physical size 
ep the resulting output file a reasonable 
ut file.

 Preferences dialog box opens and the 
ding a logo to NaviPlan documents
You can select a graphic image to be used in various locatio
locations as the top of each concept (displayed only in Repo
Report and Client Presentation. Graphics can be useful whe
for your printed or displayed materials.
The following graphic formats are acceptable:
• Windows bitmaps (BMP)

• Windows metafiles (WMF)

• Rich text format (RTF) 

It is recommended that the dimensions of the image in the g
of 4.5" and a maximum height of 2.5", otherwise the image 
under the logo will not be lined up properly on the page. It is
of the graphic file be kept as small as possible in order to ke
size. The larger the graphic file, the larger the resulting outp
To add a logo or other graphic image, follow these steps:
1. Open NaviPlan.

2. Go to the Edit menu, and then select Preferences. The
General tab is displayed.
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ialog box where you can browse to the 
 Adding a logo to NaviPlan documents

Figure 13: Preferences dialog box – General tab

3. In the Logo field, enter the path to the graphic file.

OR
Click the browse button to open the Select Logo File d
graphic file. Click OK to close the dialog box.

4. Click OK to close the Preferences dialog box.
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ing the location where client files are stored   27

Ch
these steps:

 Preferences dialog box opens, and the 

you want to store client files.

tory dialog box where you can browse to 
 OK to close the dialog box.
w on, client files will be stored in the 
Chang

anging the location where client files are stored
To change the location where client files are stored, follow 
1. Open NaviPlan.

2. Go to the Edit menu, and then select Preferences. The
General tab is displayed.

Figure 14: Preferences dialog box – General tab

3. In the Data field, enter the path to the directory where 

OR
Click the browse button to open the Select Data Direc
the directory where you want to store client files. Click

4. Click OK to close the Preferences dialog box. From no
new location.
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Ch
ions you want to use in NaviPlan. For 
utomatically open the last client file you 

 Preferences dialog box opens.
 Changing NaviPlan system options

anging NaviPlan system options
In the Preferences dialog box you can select the system opt
example, you can choose whether or not NaviPlan should a
were working on, the next time you run the program.
To change the system options, follow these steps:
1. Open NaviPlan.

2. Go to the Edit menu, and then select Preferences. The

3. Go to the System tab.

Figure 15: Preferences dialog box – System tab



Modifying NaviPlan after installation

Changing NaviPlan system options   29

se, and clear the check boxes next to the 

lient file before you open it, under File 

 changes go into effect.

For 
defa
Fea
Ref
4. Select the check boxes next to the options you want to u
options you do not want to use.

If you want NaviPlan to create a backup copy of each c
Options select the Backup option.

5. Click OK. The Preferences dialog box closes and your

more information about changing system 
ults, go to the NaviPlan Standard Advanced 
tures Guide or the NaviPlan Extended 
erence Guide. 
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Installation questions   31

Tr

In
viPlan cannot initialize its 
y installing the program?

mputer and restart it.

st NaviPlan installations are stand-alone 
tion. Reinstall to a local drive.

ey service. To determine whether or not 
lect Settings – Control Panel, and then 
pens. Look for Crypkey License in the 
dministrator access to your computer (or 

chnical Support department at 
oubleshooting your installation

stallation questions
Why do I receive a “Code – 103, ref. 35054: Na
security sub-system” message after successfull
This message can appear for several reasons:
• The system may need to be restarted. Shut down your co

• You installed the program on a shared network drive. Mo
and must be installed on a hard drive local to the worksta

• You do not have sufficient privileges to install the CrypK
the CrypKey service is running, go to the Start menu, se
double-click the Services icon. The Services dialog box o
scroll box. If the CrypKey service is not running, obtain A
the equivalent) and reinstall NaviPlan.

Note: If you are unable to resolve this error, call the EISI Te
(888) 692-3474 for assistance.
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Up
 two versions of the program on 

xisting version of the program. Uninstall 
ting version.
 Upgrade questions

grade questions
I just installed an upgrade. Why do I now have
my computer?
You installed the upgrade in a different location from your e
the upgrade and reinstall it in the same location as your exis
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Upgrade questions   33

installing an upgrade. Why did it 

stall is already installed on your 

n you want to install is already installed 

ou can then continue with the installation.
The following dialog box displayed when I was 
display and what do I do now?

Figure 16: Install Shield Wizard Repair/Remove dialog box

The dialog box displayed because the version you want to in
computer.
You can

• Click Cancel and quit the installation since the versio
on your computer.

• Select Remove to uninstall the current installation. Y
• Select Repair to continue with the reinstallation.
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Au
log box still read Not Authorized 
 correctly?
tion can be updated. The program is 
 the top of the program window.
 Authorization questions

thorization questions
Why does the Status section of the Security dia
even though I’ve entered my Authorization Key
You must close the Security dialog box before the status sec
authorized when all of the menus appear on the menu bar at
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Cho
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Cry
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D
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E
EIS
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from CD, 4
dex

horization
form, 14
key, 16
questions, 34

horizing, 13
oPlay, 4
oPlay problems, 11

Installing from, 4
Troubleshooting installation from, 11
ose Folder dialog box, 8
nt files, changing location, 27
ventions, 1
pKey service, 31
tomer Service, contacting, 14

a files, 8
changing location, 27
 space, 3

I
Customer Service, 14
Technical Support, 2
Web site, 2
r 35054, 31
luation period, 13

H
Hard disk space, 3
Help

accessing, 2
menu, 2

I
Installation problems, 31
Installing

on a stand-alone computer 

K
Keyboard references, 1

L
License agreement, 5
Logo, adding, 25

M
Memory requirements, 3
Microsoft Windows, 3
Moving authorization key, 16

N
Not authorized, 34

P
Processor requirements, 3

S
Security dialog box, 13
Shared network drive, 31
Site code, 14
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rtup options, changing, 28
tem requirements, 3
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CD, 11
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multiple versions of the program, 32
upgrades, 32
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Upgrade problems, 32
Upgrading the program, 21
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Video requirements, 3
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Windows operating systems, 3
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